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We are excited to launch our new website that features all of the same 
functions of the old website, plus new features to help you build a better 
yearbook!  You can work, stay up to date and on track from any comput-
er anytime!  Everything is organized in five easy to use sections. The new 
website offers a friendly user experience and tools to help you manage 
your time more efficiently.

Enjoy! - Entourage Website Design Team

Login to the website 
and click the Help 
Tab at the top to 
access the Entourage 
Support Contact 
Information, Video 
Tutorials, Guide 
Books, Webinars 
and More!

Helpful Hint
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ENTOURAGE WEBSITE | LOG-IN to the website

Getting started with the Entourage Website
The Entourage Website is available as soon as you sign! A default login will be sent to the Primary Contact  

on the account. NO DEPOSIT IS NECESSARY TO ACCESS THE ENTOURAGE WEBSITE. Begin setting up  
your staff and gathering images and materials right away!

LOGGING IN:
Go to www.entourageyearbooks.com
If you have a login ID:
•	 In the upper-right corner, enter your User 

Name and Password and click Login 

***User Id and Passwords for the Primary Contact are 
emailed within 24 hours of signing, please contact the  
Support Team or your Account Manager if you did not  
receive the email.

IF YOU’RE A YEARBOOK STAFF 
MEMBER AND DO NOT HAVE A 
LOGIN:
•	 Click Search For Your School
•	 Enter the name of the school 

and click Search
•	 Click the red Request Account 

Access button and fill in  
your information.

*Please allow 48 hours for processing,  
Entourage needs to verify new login  
requests with the Primary Contact. 

Welcome to the Forest Hills Elementary Yearbook
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Homepage & Tab Navigation | ENTOURAGE WEBSITE

ACTIVITY FEED:
Now it is easier than ever 
to keep track of your ac-
count. Our new Activity 
Feed feature shows you 
any new changes to your 
account (i.e. photos being 
uploaded).

DESIGN POINTS:
Entourage assigns com-
plimentary Design Points 
automatically when you 
sign up! Watch for dead-
line reminders through-
out the year more points 
may be rewarded when 
certain deadlines have 
been met!

WHAT’S NEW:
This section will give 
you information on any 
new information about 
changes made to the 
website. Keep an eye 
on this section as you 
login to keep yourself 
informed on our most 
recent updates to the 
website.

YEARBOOK PROGRESS:
Our Deadlines guide has been specifically set up 
to keep you on target with your delivery date.

To simplify the process, we only show your 
next two deadlines and tell you the overall 
completion status of the book. If you want to 
see a list of all of the deadlines as well as an  
explanation of what they are, just click on “View 
All Deadlines” It is very important to meet your 
deadlines to ensure that you will make your final 
deadline and receive your yearbooks by your  
requested delivery date.

YOUR YEARBOOK HOMEPAGE:
If you are not sure where to begin, our homepage will give you a step in the right direction. The 
buttons at the top tell you what the important first steps of the process are.
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The “Manage” tab allows 
you to  manage everything 
about your account. You 
can edit your book specs 
and account  information. 
You can setup your staff 
and their permissions on 
the website, as well as their 
tasks. You can also manage 
your pages in your year-
book ladder, and anything 
that has been uploaded for 
you to use in building your 
book.

The “Collaborate” tab  
allows you to access to 
“Explore, Share, Discuss, 
and Learn,” Within these 
sections includes Templates, 
Yearbook Contest, Certifi-
cation tests, etc.

The “Design” tab gives you 
access to the available  
designers on your website.  
All accounts have access 
to the Cover Designer, 
any other design options  
appear when applicable.

The “Upload” tab allows 
you to upload everything 
you will need to complete 
your yearbook. You can up-
load photos, pages, covers, 
and other documents that 
you might need.

The “Request” tab gives 
you the option to request 
a Proof Book, Marketing 
Materials, and/or a Year-
book Kit.

The “Help” tab is your key to 
cony to contacting us with any 
questions you may have. We 
also have online tools to help 
you right away. How-To Vid-
eos and quick start guides are 
available immediately. You 
can also sign up for our online 
training sessions right away.
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YEARBOOK RESOURCE KIT - MARKETING - PROOF BOOKS:
Use the Request Tab to order Yearbook Resource Kits, Marketing Materials and Proof Books!
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HIGHLIGHTS OF ENTOURAGE ExPLORE:

TEMPLATES- Hundreds of TOP quality 
yearbook templates.  Designed by yearbook 
professionals or yearbook staff members.

YEARBOOK GALLERY- Hundreds of ideas 
from other schools across the country.  Browse 
to see what other schools are doing. 

YEARBOOK CONTEST- browse through the 
entries from our Yearbook Contest and rate 
the ones you think should win the prize.

COVER GALLERY- Hundreds of cover options 
to choose from. Customize to make your cover 
original using your software or our online tools.

TYPOGRAPHY- Explore all the new trends 
in typography to utilize in your own yearbook.

Search through hundreds of top quality templates.  
Get ideas for your book from other schools who have 
shared their great ideas!  

Rate it!  You can rate 
all of the templates 
on the website and 
search for the most 
popular ideas!  

Get connected with others using our Share feature.  Share your great 
ideas and designs with the rest of the Entourage community!  

HIGHLIGHTS OF ENTOURAGE SHARE:

TEMPLATES - As you create amazing new 
layouts for your yearbook, share your own 
customized templates with other schools 
and help new Yearbook Coordinators get 
inspired!

YEARBOOK CONTEST- 
Share your yearbook and photography 
in our National yearbook contest, and win 
prizes for your school.

ENTOURAGE REFERRAL- Share your love 
for Entourage!  Refer us to another school 
and earn $100 credit towards your book.  
Ask your Sales Representative about our 
Group discount.

ADD A LINK - Start spreading the word 
about your yearbook on your own website 
by adding a link for your yearbook sales.

Share your templates 
and pages with the 
Entourage Community.  
We’ll replace all 
photos and text with 
placeholders so you 
don’t have to worry 
about your content 
being out on the web! 

Yearbook 
Contest
WINNER
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LeaRn
Enhance your yearbook by getting certified from our online lessons.  
It’s easy to train your yearbook staff members with Entourage Learn.  

HIGHLIGHTS OF ENTOURAGE LEARN:

GET CERTIFIED- Online yearbook lessons 
and activities. You and your staff can 
become “Yearbook Certified!”

LESSONS AVAILABLE IN THESE TOPICS:
• Yearbook Design
• Yearbook Writing
• Yearbook Interviewing
• Photography
• Entourage Website Use
• Yearbook Theme
• Entourage Page Submission
• Editing Your Yearbook
• and more...

LESSONS AVAILABLE FOR ALL LEVELS - 
No matter what age group you are working 
with, Entourage Learn has something for you! 

Take step-by-step informational 
courses to refine your yearbook 
knowledge and skills. You can take 
them anywhere, anytime, anyway 
you would like. 

DIsCUss
It’s all about communication! Make your yearbook project a success! 
Entourage makes it super easy to connect with your yearbook team, with 
the Entourage Team, and with other schools using our Live Chat and 
Message Boards. 

HIGHLIGHTS OF ENTOURAGE DISCUSS:

TECH SUPPORT- Entourage has instant chat 
features that help you get the assistance 
you need quickly. Entourage 
has the fastest tech support!

ONLINE WEBINARS - Meet with 
one of our team members as 
they guide you and a group of
your fellow advisors and staff
members through a yearbook 
related topic. A great way to 
share ideas with other schools! 

ONLINE CONFERENCING - schedule 
an online meeting where your Account 
Manager can view your computer screen to 
assist you with any questions you may have.

Chat with Entourage Yearbooks 
Team members any time if you 
have a question, need advice, or 
just want to talk yearbooks.

homepage anD tab navIgatIon
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CoLLaboRatetab
Online resources to enhance your services are also available in the new COLLABORATE TAB 
when you log into the Entourage Website.

explore
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ENTOURAGE WEBSITE | Setting up New Users on the website

HOW TO SET UP A NEW USER:
To get started, click on the link “Manage Staff” under the Manage Tab or on 
the navigation bar to the left of your homepage.

MANAGE STAFF:
Add, Monitor, and Edit your staff  login info!
1. Click the red button to add new staff member.
2. Click the name of the user to edit their information.
3. Click Delete to remove a user ID.

1.

2. 3.

3 LEVELS OF LOGIN IDS:
1. ADMIN - Recommended for Primary Contact and those 	
	 who need access to billing information.
2. EDITOR - Recommended for staff members needing 	
	 access to the designer and the ladder.
3. USER - Recommended for those needing only limited 	
	 access, such as uploading photos.
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To allow a staff member access you must  select “Approved User.” If at 
any time you need to remove a staff member just simply click on the 
members name from the  Yearbook Staff Page and select “Rejected.”

SETTING UP NEW USERS ON THE WEBSITE:
Be sure to fill in all fields for each member.

MANAGE PERMISSIONS:
Control Access!

ACCESS MANAGE PERMISSIONS: 
Under Manage Permissions you can set the access level for your staff 
member and editors. They have been preset with our suggestions but 
you can update them to fit your needs at any time.

There are three different Member Types.  Administrator, Editor, and 
Staff User. Each member type has a different level of access to the 
yearbook. You can set these levels under the Manage Yearbook  
Account section.
Notes: Administrator has full access to all yearbook information. This 
option should only be used for Yearbook Advisors.
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ENTOURAGE WEBSITE | Help & Support

In the new help section you can search for a specific topic, browse our help library, see any website or 
yearbook announcements, submit a request to update your yearbook account, watch tutorial videos, sign 
up for a webinar, request or download resource materials, and view our past hints of the week.

ENTOURAGE HELP MENU:
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You can find all tutorial videos under the “Help” tab. Just click on the video you would like to view 
and you can watch our webinars at your convenience.

You can also contact support directly if you need 
a little more assistance. We’re always happy to 
help!

Check out the webinar schedule to sign up for an on-
line course. Remember to check every month as the 
dates and times change.
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ENTOURAGE WEBSITE | Uploading and Managing Photos

To start managing your photo uploads, begin by creating your  
photo categories by click on “Create Photo Category” under 
the Upload tab. You can create a “Parent” category and then 
sub-catagories to keep you photos organized.

Once you have created your photo categories you can start uploading 
your photos. To begin, go to “Upload Photos” under the Upload tab.  
Select the category in box 1. Then click the “Select Files” button in box 2 
to search your computer for the images you would like to upload. You can 
select multiple images at once by holding the shift key. Once you have all 
your images selected, click the “Upload Files” button in box 3.
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#flowerpower #nature 

Or...UPLOAD PHOTOS FROM INSTAGRAM!

UPLOAD PHOTOS 
FROM FACEBOOK!

2.

1. To start, select the “Import 
Photos from Facebook” under 
the Upload Tab. From here login 
to your Facebook account.
2. Select the Facebook  
photo category to the left you 
would like to import images from. 
3. Select the photos you would 
like to import.
4. Select the Entourage pho-
to category you would like to 
import your images to.
5. Click the “Import Facebook 
Photos” button.

1.

5.

4.

2.

3.

1. To start, select the “Import 
Photos from Instagram” under 
the Upload Tab. From here login 
to your Instagram account.
2. You can search for photos by 
all your uploads, hashtags or 
photos that have been liked.
3. Select the photos you would 
like to import.
4. From the drop down menu, 
select the Entourage photo  
category you would like to  
import your Instagram photos to.
5. Click the Green “Import  
Photos” button.

5.4.
3.
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By clicking on an image under 
Manage Photos, you can update 
captions, tag a photo, see the  
photo properties, download or  
delete the image.

You can click Edit to rename the 
category, enter a description, 
assign a parent category, and 
also allow photos to be submit-
ted to this category via email!
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Why tag your photos?
•	 Keep track of how many times a 

student is in the yearbook.
•	 Make sure every student is 

placed in the yearbook.
•	 Easily create a student index in 

your yearbook. 

You can “like” any  
photos that has been uploaded 
to a photo category. Have your 
students like their favorites to 
make choosing images for your 
yearbook easy and fun!
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ENTOURAGE WEBSITE | Using the Yearbook Ladder

When you are 
ready to go 
to press, you 

need to submit 
your file. *

View a digital 
proof of your 

yearbook.

Preview and  
approve your 

cover file.

ADVANCED PAGE NUMBERING:
Choose the specific page you want to edit, 
the font, color and position. Using this feature 
makes it easy to customize your page num-
bering according to your background color.

SIMPLE PAGE 
NUMBERING:
Quickly add page  
numbers to your pages. 
Choose either the outer 
corner or the center.

**PLEASE NOTE: The page numbers are only place on the ladder. If you are 
using EDOnline you will not see them in the designer.

SPELL CHECK:
Useful feature to help you spell 
check your entire yearbook for 
any grammatical errors.
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To view a larger image of your pages, click on a specific page you 
would like to view and a pop up window shows a larger view of 
your pages. You can zoom in even more by scrolling your mouse 
over the page and to the right view an enlarged version of your 
page. This is great for proof text!

1. Choose which section each page should  be in 
your yearbook: Opening, Dividers, Student Life, 
Academics, People Pages, Sports, Clubs & Orga-
nizations,  Ads,  Autographs, Closing, Other.

2. Type in a title for your page.

3.  Set a due date for your page to be finished.

4. As you and your staff work on your pages, 
you can update the status of each page. Blank 
Page, Page Placed, Update Required, Incom-
plete, Page Approved.

5. You can assign pages to members of your 
yearbook staff.  Assign a single page to two 
members. Once a page is assigned to a staff 
member the task will get added to your task list 
and an email will be send  to the staff member.

6. Leave notes for your students as they work on 
their pages

1.
2.

3.
4.

5.
6.

FUNCTIONS OF THE YEARBOOKS LADDER:
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ENTOURAGE WEBSITE | ADMIN TOOLS

Update your account information from your Entourage Yearbooks Website. Update your page and book count or your delivery 
date.  Any changes made will be sent directly to your account manager. You can even view your price change if you decide to add 
upgrades to your yearbook so you can see if it is within your yearbook budget!

Personalize your Entourage Yearbook Homepage. Pick your own image, include the option for your students to order a year-
book online, upload images, purchase ads, link your yearbook to Facebook, and include an image of your cover design to spark 
interest and sales! Manage your Link account options by setting a password, open or close the online store, enable ad creation, 
and much more!
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Update your account information from your Entourage Yearbooks Website. Update your page and book count or your delivery 
date. Any changes made will be sent directly to your account manager.You can even view your price change if you decide to add 
upgrades to your yearbook so you can see if it is within your yearbook budget!

Personalize your Entourage Yearbook Homepage. Pick your own image, include the option for your students to order a yearbook 
online, upload images, purchase ads, link your yearbook to Facebook, and include an image of your cover design to spark interest 
and sales!
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Submission Page Map

Make sure 
the cover is 
approved Enter the delivery information

The number of books can be 
updated and a new invoice will 
be sent with updated pricing.

You can choose an re-sign 
option. A sales rep will contact 
you to discuss your next project. 
No information will be carried 
over without a dicussion from 
a sales rep.

Check these boxes to 
move on with the 
submission process.

Fill out these last fields
to go through with your 
final production

YOU CAN NOW APPROVE 
YOUR BOOK!

YOU WILL RECEIVE AN ERROR MESSAGE IF YOU HAVE NOT FILLED OUT ALL OF THE 
FIELDS PROPERLY. 

NO ADJUSTMENTS CAN BE MADE TO THE LADDER ONCE THE BOOK IS APPROVED!
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THIS SCREEN WILL SHOW UP ONCE THE BOOK IS PROPERLY APPROVED

Once the Production 
Approval form is completed 
and submitted, you will see 
this screen.

ONLINE PRODUCTION APPROVAL FORM

***IMPORTANT NOTE:
Once your yearbook is approved for 
production you will not be able to 
make any changes to your file. If you 
find you need to un-approve, there 
is a fee as well as an adjustment to 
your delivery date which will result in 
receiving your yearbooks at a later 
date. It is very important that you are 
absolutly sure you are ready for your 
yearbook to go to press. Entourage 
is not responsible for any mistakes 
missed during the proofing process.
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LiNK
  by ENTOURAGE YEARBOOKS

Link by Entourage Yearbooks is a user friendly 
website for parents, students, and faculty to 
interact with the yearbook. 

ONLY FROM LINK
LiNK features some Awesome NEW Technology

Upload Videos
The yearbook staff has the option of accepting 
videos!  The staff can even include printed QR 
codes in the yearbook to link to incorporate 
the videos into the book!  

NEWS FEED!Instant Updates
Link features a news feed to constantly update 
users with information about the yearbook and 
messages from the yearbook staff.  News feed 
includes updates about uploads, requests for 
specific yearbook content, surveys, and more.  

Student Features
Get the student body excited about the year-
book with Link!  Students can login and see 
which yearbook pages they’ve been tagged in 
and how many times they’re in the book.  

Link boasts a simple design and is easy for any 
user to navigate.  Parents, students and faculty 
members can quickly access the site, and search 
for the school.  

User Friendly Interface

Let your whole school community participate in 
the yearbook by submitting their pictures!  Link 
allows users from your community to quickly 
submit their photos directly to the yearbook 
staff for use in the yearbook! 

Upload Photos

Online Ad Sales
Selling ads has never been so simple!  Have 
parents and businesses log in, create, and pay 
for their ads themselves!  Online payment and 
checkout in three easy steps! 

Purchase Yearbooks
Link allows parents and students to quickly and 
securely purchase their yearbook online.  The 
yearbook advisor and staff can track year-
book sales easily online.  

Extra Security
The school and yearbook advisor can manage 
Link to only include the features that you want!  
All of the these features are optional!  

Check out our 
iPhone App for an 
easier way to get your 
photos from your phone 
to your yearbook!
(A good way to get 
parents involved to 
contribute photos too)

Parents can register a Link account by simply clicking on Purchase Year-
book on the school page, then clicking on Register at the far left. Once 
the information fields are filled out, hitting Submit will finish the process. 
Parents with Link accounts have access to all of the awesome features on 
this page!


